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To launch the Map Editor, go to the root folder for your Grey Goo game install and run the file 
“Public_PGTerrainEditor.exe”. Some Windows users, for example, may find it located in the 
C:\Program Files (x86)\Steam\steamapps\common\GreyGoo folder.  

For most users, your custom map files can be found in the 
C:\Users\(Your_Name)\Documents\Petroglyph\Goo\Custom_Maps folder by default.  

 

Important Things to Note about the Map Editor 
 When publishing to the Steam Workshop, remember that your map must meet certain 

requirements to be playable. If your map fails to meet certain requirements for gameplay, 
you may be prompted to fix any blocking issues before being able to upload it to the 
Workshop.   

 One of the requirements your map must meet is for your start markers 
(MARKER_PLAYER_START) to have sufficient space around them and meet requirements 
for level terrain. The area around the marker signified with a yellow square indicates the 
area which must be clear of obstructions and level so that all races are able to enjoy 
gameplay on the map.   

 

Potentially Useful Hotkeys 
 Spacebar – Toggles gameplay camera view states.  
 [ and ] keys – Alters the currently active brush to be smaller or larger.  
 Holding Shift and selecting an area will instantly paint that area with the selected brush.  
 Holding Control will activate the rectangle tool and instantly paint that area with the 

selected brush in a rectangular shape.  
 Alt + Left Click – Sample the height, color, or texture that is currently under the cursor.  
 Holding Ctrl + the Right Mouse Button - Allows you to quickly rotate your camera.  
 Holding Alt + Right Mouse Button - Allows you to quickly drag your camera view around 

the map.  
 Ctrl + D – Places the camera in a top-down view of the map.  
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In the Map Context Information dialog, you will have the chance to edit 3 different settings:  

 Biome Set: Here you will choose which default Biome set you will select to be the base for 
your map file. A Biome is a file containing a map’s settings which can include texture 
settings, lighting settings, environment settings, and other user-selected map options.  

o Tip: If you modify any map settings (textures, lighting, etc.) while using the map editor, 
you can save them together as your own Biome file for use later with any of your new 
or previously existing maps. Simply go to File>Save Map Biome Set to save your 
custom settings as their own Biome.  

 Width and Height In Patches: You are able to set the width and height of your map in 
“patches”, a rough unit of measurement.   

o Tip: It is highly recommended that you set a map with an equivalent width and height, 
since non-square maps can sometimes cause performance and gameplay issues.  

o Tip: For reference, Grasslands and Mountain Pass are approximately 16x16 patches.  
 Bounds Size: The bounds size will determine the size of the surrounding impassible, 

decorative area which lies on the borders of the map. This area cannot be traversed by 
any unit type, and exists to allow visual continuity.  

Click “OK” once you are satisfied with your selections. These settings can be altered after your 
map has been created if you wish to do so.  
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The “Height” tab will allow you to change the topography and structure of your terrain in both 
the passable play area and in the border area that creates the bounds of your map.  

To alter the terrain, select one of the brushes under the Brush Controls section and Left Click the 
terrain. To reverse the direction of the brush, hold down the Control key and Ctrl+Left Click the 
terrain.   

Tip: When using tools such as the surface noise brush which can rapidly change the terrain, be sure to 
repair or smooth out any visual tears in the terrain before saving and uploading your map.  

Tip: If you wish to save a set of Copy Paste brushes for use in another session or map file, simply click 
the blue diskette icon to save the file. Similarly, if you wish to import a set of Copy Paste brushes, place 
the file in the same folder as your other Copy Paste Brush Files and then select that file from the drop-
down list when in the terrain editor.  

 

 Under Brush Controls, select the brush type you would like to use.   
o Additive Brushes (Conical/Spherical) – These brushes will add or subtract height 

from the terrain in their respective shape.  
o Leveling Brush – This brush instantly sets the terrain to the height entered in the 

height field.  
o Ramp Brush – Ramps can be made from one area of terrain to another by clicking 

the start point of the ramp, clicking the end point of the ramp, and then clicking 
one last time to confirm ramp creation.  

o Clamp Height Brush – Brush that pulls terrain toward a preferred height with 
adjustable intensity and variation.  

o Surface Noise Brush – Height adjustment brush which is able to paint variable 
patterns into the terrain.  

o Copy Paste Brush – Brush used to select an area of altered terrain and copy that 
terrain for placement onto other areas of the map. Copy Paste controls will be 
activated once a section of terrain has been selected for later use with the Copy 
Paste function.  

o Terrain Mask Brush – Terrain Mask Brush – Brush used to paint a “mask” onto 
the terrain. Areas covered by a Terrain Mask are protected from alteration by tools 
which have that Terrain Mask selected.  

 There are various settings available under each brush control, some of which are only 
applicable for certain brush types:  

o Radius – Brush size.  
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o Blend Radius – Size of area within the brush closest to the preferred height; areas 
between the blend radius and the brush radius will gradually change to the 
specified height.  

o Intensity – Rate/speed at which the brush alters the terrain. 
o Smoothing – Strength of the smoothing effect applied when the brush alters the 

terrain height.  
o Clamp Height – Height at which terrain will be adjusted towards.  
o Clamp Range – Height that any terrain variations are able to occupy when terrain 

is clamped towards the Clamp Height.  
o Terrain Mask – Selects the Terrain Mask that will be used to protect terrain areas 

from alteration by this brush.  
o Freeze Objects – Check to disable automatic adjustment of objects placed on the 

terrain when terrain height changes occur.  
o Round/Square/Line – Select the shape of the brush.  

 The Copy Paste Controls section will allow you to manage and edit areas you have saved 
for use with the Copy Paste brush.  

o To use the Copy Paste brush, select it from the Brush Controls menu and Drag-
select while holding the left mouse button to select the area on the terrain that 
you wish to add to a Copy Paste brush. When you are satisfied with your 
selection, release the left mouse button.  

o Under the Copy Paste Controls, you will see both the Copy Paste Brushes that you 
have previously created that session in addition to any other Copy Paste brushes 
you have saved as a previous Copy Paste Brush File.  

o There are various settings in the Copy Paste Controls section which will alter the 
application of the Copy Paste brush you have selected:  

 Height – The absolute position value that the brush will paint onto the 
terrain.  

 Offset – The amount that the terrain features contained within the brush 
will be offset from the Height value.  

 Z Ang. – Angle position of brush in relation to original copied terrain 
features.  

 90° (R) – Rotates the selected brush at a 90 degree angle. Uses “R” 
hotkey.  

 Scale – Amplifies the copied terrain’s features by the indicated magnitude.  
 Drop – Returns the Copy Paste brush to its original Height setting. Uses 

the “D” hotkey.  
 Flip Horizontal/Vertical – Flip the direction of the brush horizontally or 

vertically.  
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 Greater/Replace/Less – The mode by which the Copy Paste brush will 
apply the new terrain to the currently existing terrain. The “Greater” option 
will only apply the brush to areas of current terrain which would be 
increased in height by the brush. The “Replace” option will completely 
replace the terrain which the brush is applied to with the contents of the 
Copy Paste brush. The “Less” option will only replace areas of current 
terrain which have a height that is lower than the height of the Copy Paste 
brush that is applied to them.  

 Color/Mats/Props/Splines/Decals – Checkmarks indicate which aspects 
of the selected Copy Paste brush that will be applied upon use to the 
current terrain.  

 Mask Color to Height – Color present on the copy paste terrain will only be 
applied to height areas which meet the placement style requirement.  

 Mask Mats to Height – Textures present on the copy paste terrain will only 
be applied to height areas which meet the placement style requirement.  

 Track Terrain – Disables the Height function of the Copy Paste brush and 
automatically adjusts the Copy Paste brush to the current height of the 
terrain under the mouse cursor.  

 Show Patch Grid – Displays the patch grid on the terrain.   
 Height Map – A visual representation of the height variations in the map. Here you can 

import and export PNG files which contain the height information of your map for later 
use.  

o Min/Max – Sets the minimum and maximum height values that will be used when 
applying the currently loaded height map to the terrain.  

o Min Camera – Game camera will never focus below the specified height. 
o Water Ht – Sets the Height of the water table. 

 Playable Bounds – Allows the user to resize and reposition the map’s playable bounds. 
o Center – The position of the map’s center point and playable area.  
o Size – The absolute size of the map.  
o Tip: When editing the Playable Bounds section, the green outline displayed on the 

terrain will indicate what changes will be made if you apply the alterations to the map. 
 Terrain Resize Tools – Changes the size of the map using absolute value or scaling. 

Allows the user to alter the alignment of the map’s playable area.  
o Center – Adjusts the alignment of the map playable area using the center point as 

reference.  
o Size – Alters the size of the map in the “patches” unit.  
o Resize – Increases or decreases the terrain size by the indicated value.  
o Rescale – Scales the currently existing terrain size to fit the indicated value. 
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o Tip: When using the Terrain Resize Tools, the green outline displayed on the terrain will 
indicate what changes will be made if you apply the alterations to the map.  

 Mirror Tool – Allows the user to mirror the terrain of their map along a central line.  
o Terrain, Splines, Decals, Props, Game Objects, Regions, Passability, Paths – 

Includes the checked items in the application of the mirror tool.  
o Mirror Reflect – Mirrors the terrain directly across the indicated line.  
o Mirror Rotate – Mirrors and flips the terrain across the indicated line.   
o Angle – Alters the angle of the central line along which the terrain will be mirrored.  
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The texture tab allows the user to paint textures onto the environmental terrain. Texture sets, 
specific materials, brushes, and cliff texture settings can be altered here.  

To place a texture material on the map, select the desired texture from the Texture Set window 
and Left-Click the Terrain. To use the Cliff Brush, select it from the dropdown menu in the “Brush 
Style” section and select the first texture in a series of matching textures, then Left-click the 
terrain to apply the material(s).   

Tip: When attempting to create natural looking terrain, use a small radius leveling brush with small 
height variations throughout an area prior to using the texture brush.  

Tip: The Cliff Healing Brush is useful for situations where preexisting cliff terrain has been readjusted 
or re-shaped and requires its cliff terrain textures to be recalculated without disrupting any surrounding 
or layered textures that are not part of that cliff brush.  

 

 Texture Set – Displays the currently loaded textures, with the selected texture outlined in 
green. These textures can be saved with the Biome, but the user can alter them 
individually in the Material settings below this section.  

o Load/Save – Loads and saves a texture set for use.  
o Replace – Upon activation, prompts the user for confirmation. The first texture 

selected (must not be currently selected) after the prompt will be the texture you 
wish to replace. The second texture you select will be the texture which replaces 
all instances of the first texture currently on the terrain. Replaced textures are still 
preserved in the Texture palette for later use.  

o Terrain Diffuse Intensity – Alters the intensity with which the diffuse settings 
impact the terrain.  

o Terrain Specular Intensity – Alters the intensity with which the terrain expresses 
its specular settings.  

 Material Settings  
o Texture Path – When selected, allows the user to specify which texture file will be 

used for that material.  
o Bump Texture – When selected, allows the user to specify which file will be used 

to render the material’s bump texture.  
o Spec Texture – When selected, allows the user to specify which file will be used to 

render the material’s specular settings.  
o Surface Type – Sets the logical type of surface represented by the material.  
o Diffuse – Changes the diffuse coloration of the texture.  
o Specular – Changes the specular tint of the texture.  
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o Material Shininess – Controls the size of the specular highlight.  
o Blend Hardness – Adjusts the hardness of the texture’s edge blending with 

surrounding textures.  
o Z Angle – Rotates the texture.  
o Scale – Sets the magnification of the base texture file that will be displayed within 

the material.  
o U Offset – Offsets the texture horizontally.  
o Tilt Angle – Stretches the perspective angle of the texture.  
o V Offset – Offsets the texture vertically.  
o Damage Material – (Not used in Grey Goo project.)  
o Lock Settings – Locks the selected material’s settings so that they cannot be 

altered.  
o Hard Edge – Prevents the material from blending with other textures placed on 

the terrain.  
o Hole – Disables the display of the currently selected material and displays a blank 

space in its place.  
 Brush Style – Controls the brush shape and settings for texture application.  

o Additive Conical Brush – Used to paint a section of texture onto the terrain.  
o Cliff Brush – Paints the sides of angled environments such as steep, cliffs, 

mountains, and other variable terrain. This tool utilizes a set of materials to apply 
various textures to different terrain angles to generate a cohesive texture 
application.  

o Cliff Healing Brush – Reapplies the currently selected Cliff Brush set to any 
previously placed Cliff Terrain texture areas, and only to those areas.  

o The Brush style dialog has various settings that alter the aspects of certain 
brushes:  

 Brush Radius – Adjusts the brush size.  
 Generate Material Normals – This modifies the Z and Tilt Angles of the 

selected materials to make them suitable for use with the cliff brush.  
 Material Count – Number of textures used to generate the Cliff Brush.  
 180°/360° – The total rotation value that is used for the Generate Material 

Normals function. Recommended setting is 180°.  
 Starting Angle – The starting angle to use for the tilt angles. Generally can 

be left at 0°.  
 Tilt Angle – Tilt angle to apply to the current set of cliff materials.  90° is 

usually the best value for this setting.    
 Line Mode – Turns the brush into a line-style brush. To begin painting, 

click the desired start point for the line, and then drag and release the 
mouse button at the desired end point.  
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Decorative props can be placed onto the terrain to further enhance your map. Trees, bushes, 
roots, decorative rocks, structures, special effects, and more can be placed and edited in the 
Props tab.  

To place a prop, select it from the list and Shift+Left Click the terrain. Props can be rotated using 
the circular “Rotate Gizmo” and can be moved around the terrain by either dragging the 
movement arrows surrounding the prop, or by Left Clicking the prop and dragging it to the 
desired location on the map. 

  

 Add Object – Lists all of the available props that can be placed on the map.  
o Search – Searches the list of available Props.  
o Map Objects Only – Only displays Props in the list which have already been placed 

on the map.  
o View Options – Displays a dialog that allows the user to toggle active selection of 

different categories of Props and Objects. Props and objects toggled off with this 
dialog still exist on the map.  

 Disable/Enable Selection – Toggles whether the current object or prop 
type is able to be selected when editing the terrain.  

 Hide/Show Objects – Toggles visual display of the currently selected 
object or prop type on the terrain.  

 Enable All/Show All – Toggles all props and object types to be selectable 
or visible.  

 Preview – Shows a visual preview of the currently selected prop or object.  
 Object Control – Displays the currently selected prop’s settings. Settings are able to be 

changed once the prop has been placed onto the terrain.  
o Name – Displays the specific name of the selected object, which will be used to 

differentiate it from other instances of the same prop which exist on the map.  
o Type – Lists the original filename of the selected prop’s model.  
o Pos X, Y, Z – Sets the absolute X, Y, and Z position values of the prop or object.  
o Z Offset – Sets the Z value in relation to terrain height.  
o Ang X, Y, Z – Adjusts the X, Y, and Z angles of the prop, its move gizmo, and its 

rotate gizmo.  
o Ignore Height – When checked, the prop will ignore changes to the terrain height.  
o World Rotation – Selected props can be rotated around a central point in the 

terrain.  
o Color – Sets the prop’s diffuse/tint color.  
o +  – Adds a new color set to the color list.  
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o Select All of Color – Will either select all props of the same color that is chosen in 
the dropdown list, or will select all props that are the same color as the prop that 
is currently selected on the terrain.  

 Alignment – Used to transfer and apply the alignment aspects of one prop or object to 
another.  

o X/Y/ Z Pos – Transfers the X, Y and Z alignment of the first prop or object.  
o Selected Min – The minimum alignment value of the first selected prop.  
o Selected Center – The center alignment value of the first selected prop.   
o Selected Max – The maximum alignment value of the first selected prop.   
o Dest Min – The minimum alignment value of the destination prop.  
o Dest Center – The center alignment value of the destination prop.  
o Dest Max – The maximum alignment value of the destination prop.  
o Align Height – Aligns multiple objects to a similar height as each other.  
o Drop to Terrain – Places the object against the terrain.  
o Apply – Applies the changes entered .  
o Alignment Mode – Enables Alignment mode and unlocks the editing of Alignment 

Rotation settings section for the currently selected prop.  
 Map Objects – Displays a list of props that are currently placed onto the map. Selecting a 

prop from the list will select the prop for editing and jump to the prop on the map.  
o Search – Searches the list of usable map objects.  

 Align Rotation – Prop alignment settings which are enabled for editing when “Alignment 
Mode” under the Alignment section is checked.  

o X, Y, and Z to X, 90°/180° – Aligns the prop in the X, Y and Z axis with respect to X.  
o X, Y, and Z to Y, 90°/180° – Aligns the prop in the X, Y and Z axis with respect to Y.  
o X, Y, and Z to Z, 90°/180° – Aligns the prop in the X, Y and Z axis with respect to Z.  

 Graphics – Toggles specific graphics settings for the selected props or objects.  
o Cast Shadow – Toggles whether the selected prop or object can create a shadow.  
o LOD – Level of detail that is required for the prop or object to appear.  
o Reflect – Prop can reflect in water plane.  
o Near Camera Fade – Allows the object to fade the closer the user views it.  
o Far Cull – Object is able to be culled from the map at a particular viewing 

distance.  
o Refract – Object is able to refract within the water plane.   
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The color tab can be used to paint and blend solid colors over terrain textures. This can help 
add complexity to map art and improve the visual depth.  

To paint color onto the map, select the desired color under the Vertex Color setting and Left-Click 
the brush onto the terrain.  

Tip: Holding shift and selecting an area will instantly paint that area with the selected color. Holding 
Control will activate the rectangle tool and instantly paint that area with the selected color in a 
rectangular shape.  

 

 Terrain Vertex Color Painting – Displays a map preview of the colors currently painted 
onto the map.  

o Recompute Color Map from Terrain – Reevaluates the color map and updates the 
map displayed to reflect a more accurate color map.  

 Brush Controls  
o Brush Radius – Alters brush size.  
o Round/Square/Line/Fill – Determines the brush type and shape.  
o Tolerance – Adjusts the color tolerance for the Fill brush type. Fill must be 

selected to enable this field.  
o Vertex Color – Color which will be painted onto terrain textures by the color tool.  
o Opacity – Alters the opacity with which the color is applied to map textures.  
o Soft Edge – If enabled, this setting will cause the brush to paint onto the terrain 

with a diffused, rounded edge.  
 Import/Export – Imports a previously created TGA file as a color map or Exports the 

currently loaded Color map as a TGA file.  
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Splines can be used to create roads, rivers, waterfalls, or variety of other similar line objects with 
animated textures on it.  

To make a new spline, select the desired Spline style from the Presets section then Shift-Left 
click on the terrain. Subsequent spline sections can be added by Ctrl+Left clicking on the terrain 
once a start point has been placed. A Spline must have at least 3 total points to display on the 
map. Spline shape and angle can be adjusted by dragging the spline’s points along the terrain.  

 

 Presets  
o Search – Search the current list of spline presets.  
o Save/Load – Save your current spline presets or load a previously saved 

collection of spline presets.  
o New – Create a new spline in the spline presets list.  
o Apply to Selection – Apply the attributes of the preset currently chosen in the 

spline presets list to the spline that you have selected on the terrain.  
 Preset Parameters – Displays the parameters of the selected spline preset. Certain 

parameters will only be displayed for certain spline types (such as river or road).  
o Surface - Determines the types of VFX emitted by units which walk upon these 

terrain items.  
o Dense Water – Texture that will be displayed around the outer edges of the spline.  
o White Water – Texture that will be displayed in the center of the spline.  
o Water Bump – Select the bump texture that will be used for the spline’s water 

surface.  
o Water Distortion – Alters the magnitude of visual distortion displayed on and 

under the spline.  
o Water Mask – Red channel of the selected texture will act as foam in the deep 

areas of the water.  
o Base Texture – Base texture that will be used for the road spline.  
o Bump Map – Bump map texture that will be used for the road spline.  
o Road Damage – Decorative texture that will be displayed on top of the road 

spline’s base texture.  
o Width – Width of the spline that will be created.  
o Scale – The scale at which the chosen water texture will be displayed upon the 

spline.  
o LOD – Level of Detail within which the spline is displayed.  
o Diffuse – Displays the tint/diffuse color of the spline.  
o Opacity – Opacity of the spline.  
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o Start – Opacity for start of spline.  
o End – Opacity for end of spline.  
o Spec – The tint/Specular lighting setting for light reflected off of the spline.  
o Specular Intensity – Represents the intensity of light reflection off of the spline.  
o Gloss – Represents how shiny/glossy the spline appears.  
o Scroll U – Speed at which the texture travels towards the start point of the spline.  
o Scroll V – Speed at which the texture travels towards the end point of the spline.  
o Clamp V – Adjusts V position of texture and bump map within the spline.  
o Clamp U – Adjusts U position of texture and bump map within the spline.  

 River Preset Parameters – Adjusts the aspects of the River Preset spline’s animation.  
o Dense Water Scroll Scale – Rate at which the Dense lower water will scroll.  
o White Water Scroll Scale – Rate at which the White water will scroll. 
o Normal Scroll Scale 1 – Rate at which the first layer of upper water will scroll.  
o Normal Scroll Scale 2 – Rate at which the second layer of upper water will scroll.  
o Distortion Scroll Scale – Magnitude of the distortion displayed upon the spline’s 

textures.  
o White Water Texture Scale U – Changes the display scale of the upper water layer 

texture.  
 Track Parameters – Specific settings related to the scrolling of the spline’s textures 

across the spline path.  
o Preset Name – Name of the spline preset that is used on the currently selected 

spline.  
o Opacity Edge 1 – Opacity of spline’s edge 1.  
o Middle – Opacity of spline’s center section.  
o Edge 2 – Opacity of spline’s edge 2.  
o Fade Distance – Depth of river spline or similar at which opacity settings begin.  
o Seg. Width – Size of the individual spline segments upon which the texture 

resides. Similar to spline angle smoothness.  
o Adj Width – Amount to adjust the spline segment width.  

 Control Point – Adjusts the aspects of the currently selected point on the spline and the 
attached spline section.  

o Z Adjust – Adjust the Z axis location of the selected control point.  
o Width – Adjust the width of only the segment that lies on the currently selected 

control point.  
o Delete – Deletes the currently selected control point.  

 Misc:  
o Remove Track – Remove the currently selected spline. 
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Decals can be used to add interesting features, imperfections, or aspects to the ground of the 
terrain.  

Shift+Left click on the terrain to place a new decal. The settings of the new decal can be adjusted 
after placement in the left side of the editor.  

 

 Decals – Currently loaded decals are displayed here for selection and use.  
o Save/Load – Saves the currently loaded set of Decals as a Decal File or Loads a 

set of Decal files into the ‘Decals’ window for use.  
o Apply to Selection – Applies the attributes of the decal currently selected in the 

‘Decals’ window to the currently selected decal present on the terrain.  
 Material Properties – Adjusts specific aspects of the decal’s material settings.  

o Render Mode – The type of mode used to render the decal. This will determine the 
appearance and environmental interaction exhibited by the decal.  

o Diffuse – Selects the texture that will be used on the decal.  
o Normal – Selects the texture that will be used on the decal.  
o Specular Intensity – Magnitude of the specular lighting effect that is being 

emitted from the Decal.    
o Gloss – Controls the size of the specular highlight.  
o LOD – Sets the level of detail at which the decal will be rendered.  

 Decal Properties  
o Lock Button – When selected, locks the X and Y Scale values to the same value.   
o Scale X – Value that represents the size of the decal along the X-axis.  
o Scale Y – Value that represents the size of the decal along the Y-axis.  
o Angle – Rotates the decal.  
o Intensity – Sets the opacity with which the texture will be applied to the terrain.  
o Tint Color – Selects a solid color with which to tint the decal.  
o Project on Cliffs – (Not used in Grey Goo project.)  
o Randomize – Randomizes the angle at which the next decal will be placed.  
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The Grass tool allows you to place animated small-scale vegetation onto the map to help 
enhance the terrain environment.  

You can paint grass onto the terrain by selecting the desired grass in the selection window, and 
left clicking on the terrain. To remove already placed grass, select the “Clear” or “Subtract” brush 
modes from the dropdown menu. 

 

 Grass Materials 
o Save/Load – Saves the currently loaded grass materials as a Material file or loads 

a set of Grass settings into the Grass Materials window.  
 Brush Settings  

o Brush Style – Selects the type of action that will be taken when the user applies 
the brush to the terrain.  

 Add – Increases the amount of grass objects on the terrain.  
 Subtract – Decreases the amount of grass objects on the terrain.  
 Clear – Removes grass objects from the terrain.  

o Brush Radius – Brush size.  
 Grass Material Settings  

o Texture – Selects the texture that will be used for the grass objects.   
o Color 0 – Selects the main/upper color of the grass objects.   
o Color 1 – Selects the accent/lower color of the grass objects.  
o Lock Settings – Locks and prevents the Grass Material Settings from being 

altered until the “Lock Settings” setting has been unchecked.  
o Density – Adjusts the amount of grass objects per terrain square for the selected 

grass material.  
o Wind Bend Scale – Adjusts the intensity of grass sway in response to simulated 

wind.  
o Width/Height – Adjusts the width and height of the grass objects.  
o Random Size – Adjusts the frequency that variable size grass object patches will 

appear for the currently selected Grass Material.  
o Tilt Angle – Tilt angle that the grass objects align in relation to the terrain. 
o Anchor X/Y – Adjusts the grass material’s anchor in relation to the X or Y axis.  
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The Water tab is where you to control what your map’s water appearance, how easily it 
becomes visible, and many other aspects of the water table.  

The water table is visible when the terrain is lowered in height enough for it to be visible. If you 
want to see the water table on your map, either lower some areas of the terrain enough for it to 
show or increase the height of the water table itself.  

 

 Load/Save Settings  
o Save/Load Settings – Save current water settings as a .wtr file or load a 

previously saved Water Settings file.  
 Generic Water Settings  

o Water Table Ht – Adjusts the height at which the water table renders. Once terrain 
falls below this value, the water table will start to render over it.  

o Opacity – Represents the overall clarity of the water and the visibility of 
terrain/objects beneath it.  

o Edge Fade Depth – Adjusts the length of distance that the edges of water areas 
will fade into terrain.  

o Fade Opacity – Clarity/Opacity of water that is rendered over edge fade areas.  
o Reflection Dis. – Amount of reflection distortion applied to prop reflections. Must 

have reflection enabled for each prop.  
o Infinite Water – Makes water near edges appear to extend into the horizon.  

 Textures Settings  
o Wave Bump – Bump texture that will be used to create the surface waves of the 

water.  
o Layers Settings  
o Water Shallow – Color of the shallow water, if set by the water depth and height.  
o Shallow Layer Opacity – Opacity of the shallow water layer, if set by water depth 

and height.  
o Behavior Settings (Wave Bump Scrolling)  
o Size – Changes the size of the texture used to render the waves on the surface of 

the water.  
o Velocity – Represents the speed at which waves in the water surface are rendered 

and displayed.  
o Direction – Alters the angle or direction in which waves on the water’s surface 

render.  



 
Page 19 of 39 

 

Environmental settings control the settings for the map sun, fog, wind, and other 
environmental effects. You can set whether your map is a night or day map, in addition to 
altering how Fog of War appears at different levels of reveal as well.  

Before proceeding with your environment settings, be sure to select a Post FX Chain from the 
dropdown list so your settings will display as they would ingame. Changing settings such as the 
map’s brightness can be done by changing the Intensity under Sun. Other environmental aspects 
like Fog and Clouds can be enabled from this tab as well.  

 

 Environment Set Operations  
o Save/Load – Save the current Enviro settings to a file for later use or select a set 

of previously used Enviro settings for use.  
o Merge – Combines the current Enviro settings with those in the file selected by 

listing the additional Enviro settings in the “Current” dropdown menu.  
o Post FX Chain – Selects which Post FX chain to use when interpreting Enviro 

settings.  
 Fog Settings – Toggles the display of mist/fog in the environment.  

o Start – The view distance at which fog begins to display into view.  
o End – The view distance at which fog begins to fade out of view.  
o Sky % – The visibility of fog in the sky area.  
o Color – Tint color of the environmental fog.  

 Sun Settings  
o Intensity – Alters the brightness of the environment sunlight.  
o Z Angle – Rotates the sunlight source around the terrain.  
o Tilt Angle – Moves the sunlight source lower or higher in relation to the terrain. 
o Ambient Color – Color of the ambient environment.  
o Diffuse – Color of the light diffusing off the terrain.  
o Spec Intensity – Intensity with which light reflects off of surfaces.  
o Shadow Bias – Opacity of shadows displayed on the map.  
o Day/Night – Denotes the map as a day or night cycle; value of 0 indicates day 

while a value of 1 indicates nighttime.  
o Force Fill Light Alignment – Assigns the additional fill lights to automatic preset 

locations in relation to the primary sun light.  
o Update Sun from Cubemap Lighting – Analyzes the lighting cubemap and 

automatically sets the sun light parameters based on the cubemap.  
 Fog of War – Allows editing of the tint and alpha values for unexplored, previously 

explored, and currently visible Fog of War.  
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o View – When checked, allows the display and editing of the Fog of War in various 
states on the editor’s map. If the “View” option is unchecked, terrain will display as 
if there is no active Fog of War.   

o Full – Display settings for unexplored Fog of War.   
o Explored – Display settings for previously explored Fog of War.  
o None – Display settings for Currently Visible Fog of War.  

 SSAO Settings – Settings for the shading and display of dynamically created shadows.  
o Radius – Amount that the shader will extend out when generating its effects.   
o Intensity – Opacity of ambient lighting occlusion.  
o Max Occlusion – Maximum allowable occlusion that will be rendered on the 

terrain itself.   
 Particle Light Settings – Alters how particle light is displayed in the map’s environment.  

o Alpha Diffuse Multiplier – Changes the diffuse color multiplier in Alpha particles.  
o Alpha Additive Multiplier – Changes the additive color multiplier in Alpha particles.  
o Bump Emissive Adder – Adds to the emissive bump color for Alpha particles.  
o Copy Sun Diffuse – Copy the selected Diffuse color under Sun Settings.  

 Sky Dome – Background texture or image that will be displayed in the sky area.  
o Dome1  

 Z Angle – Angle of the texture displayed on the lower section of the sky 
area.   

 Z Offset – Adjusts the lower skydome further or closer from the ground.  
o Dome2  

 Z Angle – Angle of texture displayed on the ceiling/upper section of the 
sky area.  

 Z Offset – Adjusts the ceiling/upper section of the sky area further or 
closer from the ground.  

 Cubemap Lighting – Manages settings related to surface reflection lighting.  
o Use Level’s Cubemap – Estimates and generates a cubemap from the Skydome 

settings.  
o Intensity – Alters the strength of the cubemap lighting.  
o Reset – Reverts cubemap lighting settings to default/none.  
o Sky Cube – Selects a file containing a group of cubemap settings.  
o Sky Cube with Sun – Selects a file containing a group of cubemap settings that 

include settings for sun cubemap lighting.   
 Fill Light Settings – Allows the use of two alternate fill lighting sources on the map.  

o Intensity 1 – Sets the brightness/stength of Fill Light 1.  
 Z Ang – Sets the Z angle of Fill Light 1.  
 Tilt Ang – Sets the tilt angle of Fill Light 1.  
 Diffuse – Sets the Diffuse color of Fill Light 1.  
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o Intensity 2 – Sets the brightness/strength of Fill Light 2.  
 Z Ang – Sets the Z angle of Fill Light 2.  
 Tilt Ang – Sets the tilt angle of Fill Light 2.  
 Diffuse – Sets the Diffuse color of Fill Light 2.  

 Weather Settings  
o Wind Dir – Wind Direction. Represents the direction that the environmental wind 

blows.  
o Environment/Grass Wind Speed – Represents the intensity/speed of the wind for 

environmental objects which animate based on this setting.  
o Cloud Size – Adjusts the size/scale of the cloud shadow projections onto the 

terrain.  
o Cloud Wind Speed – Alters the drift speed of shadows projected by cloud objects 

onto the terrain.  
o Cloud Texture – Selects the texture which is used to render the cloud shadows 

onto the terrain.  
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The Lighting tab is where you can add individual decorative light points and objects to your 
terrain.  

Individual lights can have their own tint, brightness, display frequency, and other settings which 
can be altered in the left-hand settings panel for each light. To place a light object, Shift+Left 
Click on the terrain. To move a light object, Left Click and drag the light to the desired location.  

  

 Light Type  
o Omni – Creates an Omnidirectional light.  
o Projected – Projects a light-based image onto a surface.  
o Spot – Projects light in one direction from its source.  
o Box – Creates a rectangular light.  

 Light Properties  
o Diffuse – Selects the color which the light source will diffuse onto the terrain 

around it. Applicable to all light sources.  
o Range – Selects the distance which the light source will emit light.  
o Intensity – Selects the brightness of the light source. Applicable to all light 

sources.  
o Far/Near Attenuation – Applicable to projected light sources. Adjusts the size of 

the projected light source.  
o Texture – The texture which will be displayed in/on the light source. Applicable to 

Projected and Cookie light types.  
o Night Only – If this checkbox is enabled, the light source will alter its state around 

the night/day cycle.  
o Ignore on Low-end Renderer – Indicates that the light object will not be rendered if 

the client is set to only display necessary render objects in low quality setting.  
 Time Properties  

o Noise – Variable frequency of interruption in the display of the light source.  
o Noise time – Variable duration of interruption in the display of the light source.  

 Light Orientation  
o Position Z – Alters the height at which the light is displayed.  
o Angle X, Y, Z – Used to adjust the angle at which the light object is displayed in 

the X, Y, and Z axis. Applicable to Projected, Spot, and Box lighting objects.  
 Misc  

o Delete ALL Light Sources – Deletes every light source present on the map.  
 Statistics – Displays various information about the map’s current light objects.  
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The PostFX editor will allow you to specify the different graphical settings you wish to utilize 
on your map. Effects like bloom, color correction, and Depth of Field can be adjusted here.  

Color tint of the entire map can be altered at once by adjusting the saturation and color 
correction of the PostFX settings. Default settings generally work best with a wide variety of 
maps if you wish to retain the same graphical settings as the game’s base maps.  

 

 PostFx Editor  
 HDRBloom – Allows the user to control the display of the bloom effect.  

o Enable – When checked, enables the bloom setting for clients that meet the 
requirements.  

o Bloom Cutoff – Adjusts the level at which Bloom will no longer display. 
o Bloom De-saturation – Adjusts the level of saturation in the Bloom. 
o Bloom Strength – Adjusts the strength of the Bloom effect. 

 ToneMap – Allows the user to control the display of the HDR Tone Mapping effect.  
o Exposure – Adjusts the exposure level of the entire map.  
o MaxBright – Alters relative brightness of map.  

 HeatDistortionHDR – Enables heat distortion effects for the map.  
 DepthOfField – Allows the user to control the display of the Depth of Field effect.  

o Focal Distance – Distance away from the main area of the screen that focus will 
be applied.  

o Focal Range – Range of focus area around the point of focus.  
 ColorCorrection – Allows the user to control the display of the ColorCorrection effect.  

o Black Point  
 Red/Green/Blue – Individually adjusts the Red, Green, or Blue settings of 

the Black Point for the entire map.  
 Lock RGB – Lock the relative RGB values for the black point.  

o White Point  
 Red/Green/Blue – Individually adjusts the Red, Green, or Blue settings of 

the White Point for the entire map.  
 Lock RGB – Lock the relative RGB values for the white point.  

 SaturationControl – Allows the user to control the display of the Saturation Control effect.  
o De-saturate – Reverses the Saturation setting and removes color intensity from 

the map.  
o Intensity – Magnitude at which the saturation effect is applied.  
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Gameplay objects like player spawn points, AI functionality markers, and destructible blocking 
objects can be placed in the Objects tab.  

To place a gameplay object onto the terrain, Shift+Left Click on the terrain where you wish to 
place it. To alter specific settings about the object(s) you have placed, select their associated 
spawners, which appear as green flags on the terrain. Spawner Flags can be moved around on 
the terrain to a convenient location without impacting the location of their associated objects. Be 
sure to keep objects you wish to have attackable by all players as “ENEMYPLAYER” allegiance 
(default setting), such as resource blockers or destroyable debris.  

 

 Objects  
o Search – Searches the list of Objects that are available for map placement. 
o Map Objects Only – Displays a list of Objects that are currently placed onto the 

map.  
o View Options – Displays the selection & view options panel so the user can toggle 

the display of various types of objects placed onto the map.  
 Preview, Tools, Options – Displays a preview of the Object the user has selected in the 

list.   
o Spawner Prty – Allows the user to edit the properties of the currently selected 

spawner object on the terrain.  
 Selected Spawner – Displays which spawner flag is currently selected for 

editing.  
 Edit All Spawners – When checked, all edits made to the current spawner 

will carry over to all selected spawners.  
 Undo Changes – Revert recent changes made to spawners.  
 Initially Active – When checked, the spawner activates when the instance 

has launched.  
 Max Subgroup Size – Maximum number of objects per spawn marker that 

can be present at one time.  
 Spawn Count – Total number of spawner activations per instance before 

the object will no longer spawn. A designation of -1 means the object will 
continuously respawn.  

 First Activation Delay – Amount of time that must pass before the 
spawner activates for the first time in the instance.  

 Respawn Delay – Amount of time that must pass before the spawner 
activates again.  
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 Respawn at % dead – Percentage of health missing on current object(s) 
required before the spawner will attempt to respawn a new object. A 0 
value will cause constant spawn trigger.  

 Spawned Objects – Lists the objects that will be spawned by the currently 
selected spawner.  

 Object Properties – Displays the name of the object that will be spawned 
by the currently selected spawner.  

 Is Factory – (Not used in Grey Goo Project.)  
 Spawn Type – (Not used in Grey Goo Project.)  
 Spawn Chance – Sets the probability that the particular object selected 

will be spawned when there are multiple possible objects tied to one 
spawner.  

 Level 1/2/3/4 – (Not used in Grey Goo Project.)  
 Aggro Enabled (unit can attack) – When checked, the object/unit can 

attack if possible.  
 Targetable – When checked, the object/unit can be targeted by direct 

attack.   
 Invincible (non-attackable) – When checked, the object/unit cannot be 

attacked.  
o Merge Spawners – Combines multiple currently selected spawner objects into a 

group with shared properties.  
o Split Spawner – Separates grouped spawners.  

 Object Control – Displays settings and information for the currently selected object on 
the terrain. The spawn flag for the desired object must be selected to edit certain 
settings.  

o Name – Displays the name given to the specific object that is selected. The user 
is able to rename objects by typing in this field.  

o ID – Lists a specific number identifier for the selected object on the terrain. 
o Type – Displays the base object type for the selected object on the terrain.  
o Allegiance – Represents the ‘team’ that the object will be placed on upon 

spawning. ENEMYPLAYER is the default setting required for objects that you wish 
to be attackable for all players on the map (such as destroyable debris or resource 
blockers). The allegiance setting refers to all players on the map and is only able 
to be changed on the Spawner Properties flag of an object.  

o Pos XYZ – The specific X, Y, and Z position of the currently selected object on the 
terrain. 

o Z Off – The distance of the object relative to terrain height.  
o Ang XYZ – The X, Y, and Z angle of the currently selected object on the terrain.  
o Color– Sets the object’s tint color and group.  
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o +  – Adds a new color to the color list.  
o Select All of Color – Selects all objects that are of the same color selected in the 

dropdown list or of the currently selected object.  
o Ignore Height – Object ignores adjustments to terrain height.  
o World Rotation – Objects selected can be rotated around a central point.  

 AI Marker Controls – Settings that determine which areas of a map the AI will perform 
certain actions on when playing, scouting, and defending. Refer to “AI Marker” specific 
section for more in-depth explanation.  

o Factions (Beta, Human, Goo) – The faction of the AI player for which the selected 
AI marker will apply.  

o Difficulty (Easy, Normal, Hard) – The difficulty level of the AI player for which the 
selected AI marker will apply.  

o Priority – Variable by marker; generally indicates the relative level of desire for the 
AI to fulfill the selected marker’s objectives.  

o Score – Variable by marker; generally indicates the relative amount of resources 
or units that the AI will dedicate to the selected marker.  

o Range – Variable by marker; generally indicates the area which the marker will 
impact.  

o Show Ranges – Displays a visual indicator for the selected marker’s Range value.  
 SOB Objects – Displays a list of the currently placed objects on the terrain.  

o Search - Search a list of currently placed objects on the terrain.  
 Alignment Tools – Used to transfer and apply the alignment aspects of one object to 

another.   
o X, Y, and Z Pos – Transfers the X, Y and Z alignment of an object.  
o Selected Min – The minimum alignment value of the first selected object. 
o Selected Center – The center alignment value of the first selected object.   
o Selected Max – The maximum alignment value of the first selected object.   
o Dest Min – The minimum alignment value of the destination object.  
o Dest Center – The center alignment value of the destination object.  
o Dest Max – The maximum alignment value of the destination object.  
o Align Height – Aligns multiple objects to a similar height as each other.  
o Drop to Terrain – Places the object against the terrain.  
o Alignment Mode – Enables Alignment mode and unlocks the editing of Alignment 

Rotation settings section for the currently selected object.  
o Hide Move Gizmo – When checked, hides the movement arrows that display 

when an object is selected.  
o Hide Rotate Gizmo – When checked, hides the rotation ring that display when an 

object is selected.  
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o Use World Space – Uses exact world coordinates rather than relative coordinates 
to dictate position.  

 Align Rotation – Object alignment settings which are enabled for editing when “Alignment 
Mode” under the Alignment section is checked.  

o X, Y, and Z to X, 90°/180° – Aligns the object in the X, Y and Z axis with respect to 
X.  

o X, Y, and Z to Y, 90°/180° – Aligns the object in the X, Y and Z axis with respect to 
Y.  

o X, Y, and Z to Z, 90°/180° – Aligns the object in the X, Y and Z axis with respect to 
Z.  
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Placement of gameplay objects under the Objects tab known as AI Markers will allow AI 
players to function properly on your custom map.  

You can place an AI Marker onto the terrain with Shift + Left click. Once an AI Marker has been 
placed, you can adjust the marker-specific options under the “AI Marker Controls” section in the 
Objects panel.    

 

 MARKER_PLAYER_START  
o Indicates map start locations for both User and AI players.  

 MARKER_AI_SCOUT  
o Indicates areas where AI players of any race selected will scout the area.  
o A scout marker’s Priority will adjust the importance of scouting that marker when 

the AI is determining which action to take next.  
o Resource Spigots and Start locations will always act as possible Scout areas in 

addition to any placed Scout Markers.   
o AI players will choose the unit with which to scout based upon current and past 

interactions with the enemy player during the course of the game.  
 MARKER_AI_DEFENSIVE_AREA  

o If Range, Priority, and Score are all set to 0, defensive markers can be used by Goo 
race AI players as a location that Mother Goo may use to escape from attackers. 
Can be placed on steep when utilized in this manner.  

o Eligible Beta units in defensive areas will move to occupy any nearby open wall 
pillars if they are within range of the defensive area.  

o Human AI Players which desire to construct turrets will attempt to build toward 
and place turrets within a Defensive Marker‘s range.  

o If not set to 0, the Score value of a Defensive Marker will determine the strength of 
the AI Player’s desired force that will gather at the location.   

 MARKER_AI_HUB  
o Used to indicate areas that Beta AI players will select from when deciding to place 

a power hub.  
o Hub markers are selected and used based on proximity from the AI player’s 

Headquarters/start marker.  
o Hub Markers require reasonable clearance for construction around them to 

ensure that no AI complications arise from lack of build space.  
o These markers do not require the Range or Score values to be adjusted to 

function properly.  
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 MARKER_AI_WALL  
o Used to indicate wall pillar points for selected Beta or Human race AI players.  
o MARKER_AI_WALL points must be placed within range of the AI player’s chosen 

MARKER_AI_DEFENSIVE_AREA in order for them to be valid build targets.  
o A Range value of 1 means that the AI player will have wall gates available to them 

on that section of wall.  A range value of 0 means that gates cannot be built on 
that wall area.  

o Walls of the same score will be connected together.  
o A Wall’s Priority rating will dictate the order in which it is built by the AI once it has 

selected to build a group of wall markers.  
 MARKER_AI_STAGING_AREA  

o Marks areas that the AI player of any race selected will rally and gather its units 
before sending them to attack, scout, or perform any other specific function.  

o All Brush areas on the map naturally act as Staging Area markers.  
o These markers do not require the Range, Priority, or Score values to be adjusted to 

function properly.  

 

Tips for Effective AI Implementation  
 Remember that different AI Personalities will approach combat in different ways, and 

therefore may interpret AI Markers differently from one another based on their own in-
game goals and priorities.  

 Don’t forget that you can make markers activate by difficulty as well as race. You can use 
this functionality to make your AI players behave progressively more skillful through the 
use of difficulty-specific AI Markers. For example, you could create advanced scouting 
locations that only an AI player of Hard difficulty level on your custom map will utilize.  

 Use carefully placed Defensive Markers to aid your AI players in creating a robust and 
well-constructed base area.  Even though AI players will take desired defensive measures 
without the need for specific marker placement, judiciously placed defensive markers 
around a base could give your Human AI’s sentinel placement the tactical edge it needs 
to keep enemy players at bay.  
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The Passability tool will allow you to alter the pathing aspects of different terrain types, add 
brush areas, and change visibility/targeting behavior on the map.  

If you wish to have passability automatically calculated for your map, you can simply click the 
“Generate Default” button to have the map editor generate a rough passabilty map. To manually 
alter the passability, select the desired passability type from the Passability brush controls 
section and Left Click the terrain. To change the type of passability you are applying (movement, 
brush, etc), select the desired category from the dropdown menu.   

Tip: When creating brush areas on your map, the context value is important.  Brush areas with the 
same context value will share vision, so be sure to give a new context value to every brush area on your 
map if you want them to each grant their own individual vision areas.  

 

 Passability Brush Controls – Allows selection and editing of different movement, brush, 
visibility, and targeting areas.  

o Passability Category – Selects the category of movement types desired for 
editing.  

o Generate Default – Directs the Map Editor to attempt to automatically apply the 
appropriate Movement and Visibility passability types based on terrain height and 
shape.  

o Passability Type – Lists different kinds of passability for editing that fall under the 
Passability Category selected. A checkmark next to the name of the Passability 
type indicates that it is shown on the map and ready for editing. The color 
displayed after the type name indicates the overlay which is used to represent 
that type.  

o Radius – Brush size.  
o Set All – Checks all listed Passability Types for editing and display.  
o Clear All – Unchecks all listed Passability Types for editing and display.  
o Context Value – The group designation which the next brush area will be painted 

as.  
o Current Context Value – The group designation of the brush area that is currently 

under the mouse cursor.  
o Round/Square/Line Brush/Flood Fill – Shape of the brush used to paint 

passability onto the terrain.  
 Height Map – Visual representation of the current passability painted onto the map.  
 Debug Display Tools – Allows the user to select different modes of movement, visibility, 

and pathing for visualization on the current passability map.  
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The Instance options tab allows you to set instance options such as player count and map 
name. The Instance tab is also where you can add resource fields and spigots.  

To add a resource field, click the “Add” button and name the resource field. Then, Leftclick the 
terrain to paint the areas in which that field will appear ingame. Spigots can be added to the field 
by selecting the “Edit Spigots” option and then Shift-Left clicking in the resource field. Spigots can 
also be added to the resource pool by dragging them into the field. To change the amount of 
resources in a resource pool, select it from the Resource Fields section, alter the amount of 
resources in the “Resources” field, and press Enter.  

Tip: If you are having difficulty visualizing resource field sizes relative to drain efficiency rates, 
remember that a brush size of size 3 Is approximately 8 drain, brush size 4 is approximately 10 drain, 
and brush sizes 6 or higher are approximately 13 drain.  

 

 Instance Settings – General map gameplay settings.  
o Max Players – Determines the amount of players which the map will contain.  
o Map Description – Brief description of the map.  

 Resource Fields – A list of Resource fields and Spigots that are currently present on the 
map. A spigot must reside within a resource field for it to be valid.  

o Search – Search the list of resource fields on the current map.  
o Resources – Adjusts the amount of resources available within the selected 

resource field.  
o Desc – The custom description for the currently selected resource field.  
o Add – Adds a new resource field to the map.  
o Hide All – Disable display of all unselected resource areas on the map.  
o View All – Enable display of all resource areas on the map.  

 Resource Field Tools – Allows the alteration of resource field areas and 
placement/deletion of Spigots.  

o Round/Square/Line/Flood Fill – Alters the shape of the brush to the desired 
shape.  

o Brush size – Changes the size of the resource painting brush. Resource drain 
efficiency is dependent upon the size of a resource field’s width.  

o Edit Spigots – Allows the addition and deletion of resource spigots onto the 
terrain in a manner similar to Object placement.  

o Erase – Turns the brush tool into a Resource field erase tool.  
o Lock Unselected – Only the currently selected resource field is able to be altered 

by the Resource field tool brush.  
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 Resource Map – Displays a visual representation of the current resource field areas and 
spigots present on the map.  
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The Audio tab allows you to set audio events which will determine which audio files play in 
certain areas. It will allow your map to have a unique combination of ambient sounds.  

To start a new Audio path, Shift+Left click on the terrain. Hold the Shift button and Left Click on 
subsequent areas that you wish to denote the borders of the audio activation/origination area.  

 

 Audio Paths  
o Current Audio Paths List  

 Path – Indicates the specific Audio Path denoted by the entry.  
 Looping Event – Lists the Looping Audio Event present in the indicated 

audio path.  
 Random Event – Lists the Intermittent Audio event present in the 

indicated audio path.  
 Edges – Number of edges or borders present on the Audio Path.  

o Looping Event – Event which will constantly play in the next audio path that is 
created.  

o Intermittent Event – Event which will periodically play in the next audio path that 
is created.  

 Mini Map – Visual representation of the current Audio Paths present on the map terrain.  
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Please note that the Grey Goo Custom Asset 3DS Max plugin is intended for use in 3DS Max 
32-bit only. 

You can download the plugin here: http://content.greygoo.com/GooAssetTools.zip 

Tip: When adding custom props to your maps, those props must be stored in the map file to be 
shareable with others – keep in mind that map file sizes will grow accordingly. Additionally, it is 
important to note that the complexity of the model will be a large determining factor in the speed at 
which the Asset plugin can process the file. 

Tip: Remember to center your prop in 3DS Max before exporting – otherwise, it may experience issues 
if viewed in the Asset Viewer or when you are attempting to properly position it in the Terrain Editor. 

Tip: Any texture files used must be represented in powers of 2 (ex. 256x256, 512x512, 1024x1024). 
Texture files of size 512x512 are recommended for best results. Texture files should be in Targa 
(.TGA) format. 

Tip: Two main conventions exist in Grey Goo shaders: that used for terrain textures and that used for 
“hdr_mesh_standard”/”hdr_skin_standard” shaders. Those who are interested in further adapting their 
texture files to fit Grey Goo conventions may refer to the following table: 

 

Terrain Shader Conventions 
 RGB A 

BaseTexture Diffuse color (albedo) 
Alpha channel mask (Used in the cross-

fade blends between different terrain 
materials) 

SpecularTexture Spec color (unused) 
NormalTexture (Bump) Normal Specular Gloss 

 

 

HDR_xxx_Standard Shader Conventions 
 RGB A 
BaseTexture Diffuse color (albedo)  
SpecularTexture Spec color Emissive Mask 
NormalTexture (Bump) Normal Specular Gloss 

EmissiveTexture 
(Emissive color which scrolls 

underneath the Emissive 
Mask) 

 

 

http://content.greygoo.com/GooAssetTools.zip
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 Install max2alamo plugin in 3DS Max 
o Locate and extract GooAssetTools.zip 
o In 3DS Max, go to Customize>Configure System Paths>3rd Party Plug-Ins 
o Click Add, and navigate to the GooAssetTools folder (extracted from the zip file) 
o Go to the subfolder /UserAssetPipeline/Tools/Bin/Max2013, click Use Path then click 

OK. 
o Restart 3DS Max. 
o Add the Alamo Utility to the UI by clicking the “Configure Button Sets” tab in the 

right-hand Utilities menu, scrolling down to “Alamo Utility,” and dragging the 
Alamo Utility onto the bar. Click OK. 

 Assign a DirectX Material to the asset 
o Go to the Material Editor 
o Click Material>Get Material 
o Double click to select DirectX Shader, then exit the Material/Map Browser window 
o Click on the path listed for “DirectX Shader” and navigate to 

/GooAssetTools/UserAssetPipeline/AoC/Art/ShadersHDR/Max/objects 
o Select a shader from the list (hdr_mesh_simple.fx and hdr_mesh_standard.fx work 

for most assets) and click Open. 
o Place any custom textures that you wish to use with the DirectX shader within the 

appropriate folder under the /GooAssetTools/UserAssetPipeline/AoC/Art 
/TexturesHDR directory. Textures which are located outside of this directory may 
not properly export with your asset. For best results, specific texture types can be 
placed in the following subfolders: 

 Base Texture: /GooAssetTools/UserAssetPipeline/AoC/Art 
/TexturesHDR/Game 

 Bump or Normal Texture: /GooAssetTools/UserAssetPipeline/AoC/Art 
/TexturesHDR/Bump 

 Specular Texture: /GooAssetTools/UserAssetPipeline/AoC/Art 
/TexturesHDR/Spec 

 Emissive Texture: /GooAssetTools/UserAssetPipeline/AoC/Art 
/TexturesHDR/Game 

o Select the textures you wish to use on your asset from within the 
/GooAssetTools/UserAssetPipeline/AoC/Art /TexturesHDR directory (and associated 
subfolders) for each option under the Parameters section of the Material Editor. 

o Select the desired area(s) of your asset and click “Assign Material to Selection” 
and then exit the Material Editor. Do not worry if your textures display differently 
than you intend (appear shaded differently, or are transparent to varying degrees). 
Texture appearance in the 3DS Max program will likely have a different 
appearance in the viewport window than in the Grey Goo Map Editor and in game, 
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so it is always best to check the appearance of the asset in the Asset Viewer or 
Map Editor. 

 Ensure that your asset’s animations export with the model 
o With the asset open in 3DS Max, go to the right hand side Utilities menu>Alamo 

Utility. You may need to scroll through or resize the Alamo Utility window if there 
are some settings which are out of view. 

o Select your asset(s) in the view window and then check the “Export Bone” and 
“Export Geometry” boxes. Under Animation Settings, select “Export Multiple 
Anims”. 

o Click Add to add the animation to the list of animations on the Anims tab below. 
o Select the newly created animation from the list below and enter an Anim Name. 
o Anim names should be in the format “Idle_##” where ## is a number designation 

from 00 to 09. For example, Idle_00 would be a valid animation name. 
o Ensure that the “Anim Override Name” box is blank – otherwise your animations 

may not display in the AssetViewer. 
o Select an Overlay Root from the drop-down list and enter the Start/End frames for 

your animation, pressing Enter after each entry. You may now exit the Alamo 
Utility. 

 Export as an .alo file for use in the Editor 
o Once satisfied with the asset and animations, go to the main menu and click 

Export>Export (non-native format) 
o Select “Alamo Object (*.ALO)” from the dropdown list of filetypes and save your 

custom asset to the /GooAssetTools/UserAssetPipeline/AoC/Art/ModelsHDR/Props 
folder.  

 Set up the Game XML to reference your Custom Objects 
o Navigate to the 

/GooAssetTools/UserAssetPipeline/AoC/XML/Custom_User_Objects/Props folder 
o Create a copy of the UserProps.xml template file in the same folder and then open 

the new copy with a text editor. 
o Edit the file to reference your newly created asset: 

<ObjectTypeClass Name="User_Crystal_Test_Prop" Classification="Decoration"> 
<ActorAnimationComponent> 

<AssetName>PR_OB_Crystal_00_00.alo</AssetName> 
<Scale>1</Scale> 
<EnableNearCameraFade>False</EnableNearCameraFade> 
<IsOpaqueNonOccluding 
network="client">True</IsOpaqueNonOccluding> 

</ActorAnimationComponent> 
<PositionComponent /> 

</ObjectTypeClass> 
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o Replace “User_Crystal_Test_Prop” with a name to be displayed for your custom 
asset. 

o Replace “PR_OB_Crystal_00_00.alo” with the name of the .ALO file you exported 
from 3DS Max, located in the 
/GooAssetTools/UserAssetPipeline/AoC/Art/ModelsHDR/Props folder. 

o Save the XML file with a new name (ex. MyCustomProps.XML). 
o Navigate to the /GooAssetTools/UserAssetPipeline/AoC/XML folder and open 

UserFiles.XML with a text editor. 
o Edit the file to contain a new entry pointing to the XML file listing your custom 

props: 
File appears as… 
<Game_Object_Files> 

<File>Custom_User_Objects\Props\UserProps.xml</File> 
</Game_Object_Files> 

Add a reference to your new XML file prop list: 
<Game_Object_Files> 

<File>Custom_User_Objects\Props\UserProps.xml</File> 
<File>Custom_User_Objects\Props\MyCustomProps.XML</File> 

</Game_Object_Files> 
o Save the changes to the UserFiles.xml file. 

 Prepare your Editor and Asset Viewer to use your new Custom Assets 
o Navigate to \GooAssetTools\UserAssetPipeline and Run the “RunAssetProcess.bat” 

file (may require “Run as Administrator” for some Windows systems). 
o Click GO to begin preparing your game assets for use. 
o Once the process has completed (the button has returned to the “GO” state from 

“STOP”), you may close the Asset Process window. 
o Check that the asset processing was successful by navigating to the 

\GooAssetTools\UserAssetPipeline\Aoc\RUN\USERASSETS folder and verifying that 
there is an updated USERDATA.MEG file in this location. If the USERDATA.MEG 
file located within this folder is not labeled as being last updated at the time when 
you used RunAssetProcess.bat, you can delete the USERDATA.MEG file and use 
RunAssetProcess.bat again to rebuild the file.  

o The custom asset should now be available in the Map Editor. 
 Place your new asset on a Custom Map 

o Open your Map Editor and load a new or previously created map. 
o Navigate to the Props tab. 
o Under the Add Object window, go to the Custom_User_Objects folder. 
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o Your custom prop sections should display in this area. The MyCustomProps 
folder, for example, will be located here if that is what was referenced in the 
UserFiles.XML folder. 

o Open your prop folder to display any referenced custom assets. 
o Select your prop(s) from the list and place them onto the map with Shift+Left 

Click, like any other decorative prop. 
o The prop is now viewable ingame on your custom map! 

 View your custom assets in the AssetViewer 
o Your custom assets and any associated animations can be viewed separately 

from the Terrain Editor by inspecting them using the Asset Viewer tool. To use the 
Asset Viewer, first navigate to \GooAssetTools\UserAssetPipeline and Run the 
“RunAssetProcess.bat” file (may require “Run as Administrator” for some 
Windows systems). 

o Next, run the RunAssetViewer.bat file (may require “Run as Administrator” for 
some Windows systems). 

o When prompted, select the working directory. This will be the directory where your 
Grey Goo game is installed. On some Windows systems, for example, you can find 
this located at \Program Files (x86)\Steam\steamapps\common\GreyGoo. You can 
change this location later if needed by going to File>Set Working Directory. 

o Open the asset you wish to view by going to File>Open, then navigating to and 
selecting the desired asset file. 

o The asset should now display in the preview window. 
o To view the file’s animations, click to the Animations tab and select the animation 

you wish to view from the dropdown menu(s). 
o To alter the background of the preview window, click the Scene tab and adjust the 

settings in the Scene window. 
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